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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed 
as constituting an additional warranty. HP shall not be liable for technical or editorial errors 
or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or 
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed 
to the U.S. Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental 
information. Site content and availability may change without notice. HP makes no 
representations or warranties whatsoever as to site content or availability.

Copyright Notices

© Copyright 1993 - 2012 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft® is a U.S registered trademark of Microsoft Corporation.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition, visit the 
HP Quality Center Add-ins site:

From the main Quality Center window, select Help > Add-ins Page.

Additional HP Quality Center documentation is also available by visiting the following URL:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.You will also 
receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

Welcome to the HP Quality Center Microsoft Word Add-in, which enables 
you to export requirement data or test plan data from a Microsoft Word 
document directly to the Quality Center Requirements module or Test Plan 
module. 

Note: This guide explains how to use Microsoft Word with Quality Center. 
For additional information on using Quality Center, refer to the 
HP Quality Center User Guide.

How This Guide is Organized

This guide contains the following chapters:

Chapter 1 Installing the Microsoft Word Add-in

Describes how to install the Microsoft Word Add-in.

Chapter 2 Formatting Requirement and Test Plan Data

Describes how to format requirement data and test plan data in a Word 
document.

Chapter 3 Exporting Data to Quality Center

Describes how to export the data to Quality Center.
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1
Installing the Microsoft Word Add-in

This chapter describes how to install the Microsoft Word Add-in on your 
client computer. This add-in enables you to export requirements or test 
plans from Microsoft Word to Quality Center.

Before you install the Microsoft Word Add-in, make sure that Microsoft 
Word is installed on your client computer.

Note: To install this add-in, you must log in with administrator privileges.

To install the Microsoft Word Add-in:

 1 Close Microsoft Word.

 2 Uninstall any previous versions of the Microsoft Word Add-in. To uninstall, 
choose Start > Settings > Control Panel > Add/Remove Programs and follow 
the instructions on your screen.

 3 Open the HP Quality Center Add-ins page:

➤ If you are logged in to Quality Center or Site Administration, select Help 
> Add-ins page.
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➤ If you are not logged in to Quality Center or Site Administration, open 
your Web browser and type your Quality Center URL: 
http://<Quality Center server name>[<:port number>]/qcbin. The 
HP Quality Center Options window opens.

Click the Add-Ins Page link.



Chapter 1 • Installing the Microsoft Word Add-in

11

 4 The HP Quality Center Add-ins page opens.

Click the More HP Quality Center Add-ins link. The More HP Quality Center 
Add-ins page opens.

 5 Under Microsoft Office Add-ins, click the Microsoft Word Add-in link. The 
Microsoft Word Add-in page opens.

 6 Click the Download Add-in link. Follow the on-screen installation 
instructions.

 7 Navigate back to the HP Quality Center Add-ins page and click the 
HP Quality Center Connectivity Add-in link. The HP Quality Center 
Connectivity Add-in page opens.

 8 Click Download Add-in and install the HP Quality Center Connectivity 
Add-in on your Quality Center client machine.

 9 Configure your Microsoft Word security settings after you install the Word 
Add-in. For more information on configuring Word security settings, refer to 
the Microsoft Word documentation.

 10 To access this guide, choose Start > Programs > Quality Center 10.00 > 
Integrations > Microsoft Add-ins.
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2
Formatting Requirement and Test Plan 
Data

The Microsoft Word Add-in installs macros in Word. You use these macros 
to format requirement or test plan data in your Word document.

This chapter includes:

 ➤  About Formatting Requirement and Test Plan Data on page 13

 ➤  The Microsoft Word Add-in Toolbars on page 14

 ➤  Formatting Requirement Data on page 15

 ➤  Formatting Test Plan Data on page 26

 ➤  Deleting Formatting from the Document on page 34

About Formatting Requirement and Test Plan Data

Before you can export requirement and test plan data from Word to 
Quality Center, your data must be placed in your document as paragraphs 
or as tables. Then you use the Microsoft Word Add-in toolbar buttons to 
mark the requirement or test plan fields. Any text in the document that is 
not marked is ignored.

You can format the requirements so that when you export them to 
Quality Center, the requirements are on the same hierarchical level, or on 
different hierarchical levels in the requirements tree. When formatting a test 
plan, you can format the subject folders on the same hierarchical level, or 
on different hierarchical levels in the test plan tree. 
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The Microsoft Word Add-in Toolbars

After you install the Microsoft Word Add-in and enable the macros, the 
Microsoft Word Add-in toolbars are available. 

The Microsoft Word Add-in adds the following toolbars:

➤ Quality Center Common toolbar. Contains buttons commonly used when 
exporting requirements and test plans.

➤ Quality Center Test Plan toolbar. Contains buttons used when formatting 
test plans.

➤ Quality Center Requirements toolbars. Contain buttons used when 
formatting requirements.

To display or hide the Microsoft Word Add-in toolbars:

➤ Word 2003. Choose View > Toolbars and choose the toolbar you want to 
display or hide.

➤ Word 2007 and 2010. Click the Add-ins tab. Click the Quality Center button 
and choose the toolbar you want to display or hide.

Quality Center 
Common toolbar

Quality Center 
Test Plan toolbar

Quality Center 
Requirements 
toolbars
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Formatting Requirement Data

Before you can export requirement data from a Word document to 
Quality Center, data must be placed as paragraphs or as tables. In addition, 
if you want to export requirement types and user-defined fields, you must 
first import their definitions from your Quality Center project.

You then use the Microsoft Word Add-in toolbar buttons to mark the 
requirement fields. You can format the requirements so that when you 
export them to Quality Center, the requirements are on the same 
hierarchical level, or on different hierarchical levels in the requirements 
tree.

This section includes:

➤ Placing the Requirement Data in the Document

➤ Importing Requirement Types

➤ Marking the Requirement Fields

➤ Example: Requirements on the Same Hierarchical Level

➤ Example: Requirements on Different Hierarchical Levels
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Placing the Requirement Data in the Document
The Word document can contain requirement data as paragraphs or as 
tables. 

When the data is provided as paragraphs, each field of the requirement must 
be on a separate line. For each requirement, the name of the requirement 
must appear first, followed by other requirement fields. The following 
example shows data for two requirements placed as paragraphs:

When the document contains a table, each row must contain the data for a 
requirement. The first column must be the name of the requirement. The 
following example shows the data for the same two requirements, listed in a 
table:
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Importing Requirement Types
You can import definitions for requirement types and their associated 
user-defined fields from a Quality Center project to your Word document. 
You can then define and export the requirement type for each requirement 
in your Word document. After you define a requirement type for a 
requirement, you can export values for user-defined fields that are available 
for requirements of that type.

To import requirement types from a Quality Center project:

 1 Click the Import Requirement Type Definitions button. The Requirement 
Type Definitions Wizard - Step 1 of 5 dialog box opens.

Type your Quality Center URL:
http://<Quality Center server name>[:port]/qcbin.
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 2 Click Next. The Requirement Type Definitions Wizard - Step 2 of 5 dialog 
box opens.

Enter your Quality Center user name and password. 

 3 Click Next. The Requirement Type Definitions Wizard - Step 3 of 5 dialog 
box opens.

Select a Quality Center domain and project. 
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 4 Click Import. The add-in imports the requirement types and user-defined 
fields from the Quality Center project.

 5 After the add-in imports the requirement types and user-defined fields, the 
Requirement Type Definitions Wizard - Step 5 of 5 dialog box opens. Click 
Finish. The requirement types and user-defined fields are updated in the 
Word document.

Marking the Requirement Fields
After placing your data as paragraphs or as tables, you must mark your 
requirement fields. To mark a requirement field, highlight the text and click 
the appropriate button on the Quality Center Requirements toolbar. An icon 
is added next to the marked text line. A bookmark is inserted into the 
document to allow the add-in to identify the marked text when it is 
exported to Quality Center. 

When marking requirement fields, consider the following:

➤ For each requirement, the requirement name must be provided. You can 
also export the requirement type, review status, author, priority, description, 
and rich text. In addition, if you export the requirement type, you can 
export data for user-defined fields available for the type.

➤ If a requirement with the same name exists in the requirements tree, the 
fields of the requirement are changed to contain the new values. If your 
document contains two requirements on the same hierarchical level with 
the same name, only the second requirement is created.

➤ If the review status is not provided, the default value is Not Reviewed.

➤ The data for each field should be on the same line as the icon that marks it. 
The only exceptions are the Description field and rich text. Data for the 
Description field can extend to additional lines and can include returns and 
indents. Rich text data can include any content that you can include in a 
regular Word document.

➤ Data intended for Quality Center fields that have selection lists must match 
the entries in those selection lists exactly. For example, the Priority field can 
only accept one of the following entries: 5-Urgent, 4-Very High, 3-High, 
2-Medium, or 1-Low.
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➤ You cannot export data for user-defined fields that do not exist in the 
Quality Center project, or which are not available for the requirement type.

To mark the requirement fields:

 1 Open a Word document containing requirement text.

 2 You can use the Structure Checker to ensure that you do not insert 
bookmarks that invalidate the structure. For example, the Structure Checker 
makes sure that you do not add more than one name to a requirement, or 
close a requirement before you have opened it. To switch the Structure 
Checker on or off, in the Quality Center Requirements toolbar, click the 
Turn On Structure Checker button or Turn Off Structure Checker button.

 3 Highlight a text line or a table cell in your document, and click the 
appropriate button in the Quality Center Requirements toolbar:

 4 To assign a requirement to a type, add and highlight a new text line in the 
data for the requirement, or add a new table column and highlight the cell 
in the new column corresponding to the requirement. In the Quality Center 
Requirements toolbar, in the Type box, select a requirement type. Click the 
Type button to add the requirement type to the document. The requirement 
type is added and is indicated by the Requirement Type icon .

 5 To assign a value to a user-defined field, highlight the text line or table cell 
in your document containing the value. In the Quality Center Requirements 
toolbar, in the Field box, select a user-defined field. Click the Field button to 
mark the value with the User Defined Field icon .

 6 To add rich text to be exported to Quality Center, highlight the rich text 
and click the Open Rich Text button. The Open Rich Text icon  is added 
to indicate the beginning of the rich text. 

Field Toolbar Button Icon

requirement name

review status of the requirement

author of the requirement

priority of the requirement

description of the requirement
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Place the cursor at the end of the rich text you want to add and click the 
Close Rich Text button. The Close Rich Text icon  is added to indicate the 
end of the rich text.

 7 Repeat for all requirement data. Any text in the document that is not 
marked is ignored.

 8 Click the Close Requirement button to close each requirement with the 
Close Requirement icon . The location of this mark depends on whether 
the requirements are on the same hierarchical level or on different 
hierarchical levels.

For more information, see “Example: Requirements on the Same 
Hierarchical Level” on page 22, and “Example: Requirements on Different 
Hierarchical Levels” on page 23.

 9 To unmark one or more fields, use the undo buttons or remove the mark 
manually. For more information, see “Deleting Formatting from the 
Document” on page 34.

 10 When all requirement fields have been marked, export the requirements to 
Quality Center. For more information, see Chapter 3, “Exporting Data to 
Quality Center.”
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Example: Requirements on the Same Hierarchical Level
To define requirements on the same hierarchical level in the requirements 
tree, use the Close Requirement button to place the Close Requirement 
mark directly after each requirement. This causes a requirement to be placed 
on the same level as the preceding requirement.

When the document contains paragraphs, insert a line after the last line of 
the requirement and mark it with the Close Requirement mark: 
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When the document contains a table, add a column to the end of the table, 
and insert the Close Requirement mark for each requirement: 

After you export the requirements to Quality Center, the requirements are 
displayed on the same hierarchical level, under the root requirement. 

Example: Requirements on Different Hierarchical Levels
You can define a requirement to be a child requirement of the preceding 
requirement. Use the Close Requirement button to place the Close 
Requirement mark for the parent requirement after all its child 
requirements. 

For example, to define Req_2 as a child of Req_1, and Req_3 and Req_4 as 
children of Req_2, place the Close Requirement mark for Req_2 after the 
definitions of its child requirements. Place the Close Requirement mark for 
Req_1 at the very end. 
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When the document contains paragraphs, place each Close Requirement 
mark on its own line in the appropriate location. Note that the Close 
Requirement marks for Req_1 and Req_2 are inserted after Req_3 and Req_4. 
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When the data is provided as a table, add a column to the end of the table 
and place each Close Requirement mark in the appropriate location: 

After you export the requirements to Quality Center, Req_2 is displayed as a 
child of Req_1, and Req_3 and Req_4 are displayed as children of Req_2.
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Formatting Test Plan Data

Before you can export test plan data from a Word document to 
Quality Center, you can place data as paragraphs or as tables. You then use 
the Microsoft Word Add-in toolbar buttons to mark the test plan fields. You 
can format the test plan fields so that when you export them to 
Quality Center, the subject folders are on the same hierarchical level, or on 
different hierarchical levels in the test plan tree.

This section includes:

➤ Placing the Test Plan Data in the Document

➤ Marking the Test Plan Fields

➤ Example: Subject Folders on the Same Hierarchical Level

➤ Example: Subject Folders on Different Hierarchical levels



Chapter 2 • Formatting Requirement and Test Plan Data

27

Placing the Test Plan Data in the Document
The Word document can contain test plan data as paragraphs or as tables. 

When the data is provided as paragraphs, each field of the test plan must be 
on a separate line. For each subject folder, the name of the subject folder 
must appear first. The tests of that subject folder must appear under the 
name of the subject folder. The test steps of each test must appear under the 
test. The following example shows the data for two subject folders, each 
with one test containing one test step.
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When the document contains a table, the first column must be the name of 
the subject folder. The following example shows the data for two subject 
folders, listed in a table. In this example, Subject_2 contains two tests and 
Test_3 contains two test steps:

Marking the Test Plan Fields
After placing your data as paragraphs or as tables, you mark your test plan 
fields. To mark a test plan field, highlight the text and click the appropriate 
button on the Quality Center Test Plan toolbar. An icon is added next to the 
marked text line. A bookmark is inserted into the document to allow the 
add-in to identify the marked text when it is exported to Quality Center. 

When marking test plan fields, consider the following:

➤ You can export subject folders, tests and test steps. For a test you can export 
the test name, status, designer, and description. For a test step you can 
export the test step name, description, and expected results.

➤ To define a subfolder for an existing subject folder, place the new subfolder 
definition under the existing subject folder name.

➤ If a test step with the same name exists on the same level in the test plan 
tree, the test step is changed to contain the new information. If your 
document contains two test steps on the same hierarchical level with the 
same name, only the second test step is created.
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➤ The data for each field should be on the same line as the icon that marks it. 
The only exceptions are the Expected Results field and the Description field. 
Data for these fields can extend to additional lines and can include returns 
and indents.

➤ Data intended for Quality Center fields that have selection lists must match 
the entries in those selection lists exactly.

To mark the test plan fields:

 1 Open a Word document containing test plan text.

 2 Highlight a text line or a table cell in your document, and click the 
appropriate button on the Quality Center Test Plan toolbar:

 3 Repeat for all test plan data. Any text in the document that is not marked is 
ignored.

 4 Click the Close Folder button to close each subject folder with the Close 
Folder mark . The location of this mark depends on whether the folders 
are on the same hierarchical level or on different hierarchical levels.

For more information, see “Example: Subject Folders on the Same 
Hierarchical Level” on page 30, and “Example: Subject Folders on Different 
Hierarchical levels” on page 31.

Field Toolbar Button Icon

subject folder name

test name

current status of the test

designer of the test

description of the test

test step name

description of the step

expected results of the step 
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 5 To unmark one or more fields, use the undo buttons or remove the mark 
manually. For more information, see “Deleting Formatting from the 
Document” on page 34.

 6 When all test plan data has been marked, export the test plan to 
Quality Center. For more information, see Chapter 3, “Exporting Data to 
Quality Center.”

Example: Subject Folders on the Same Hierarchical Level
To define subject folders on the same hierarchical level in the test plan tree, 
use the Close Folder button to place the Close Folder mark directly after the 
data for each subject folder. This causes a subject folder to be placed on the 
same level as the preceding subject folder.

When the document contains paragraphs, insert a line after the last line of 
the subject folder data and mark it with the Close Folder mark: 
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When the document contains a table, add a column to the end of the table, 
and insert the Close Folder mark at the end of the data for each subject 
folder: 

After you export the test plan to Quality Center, the subject folders in the 
test plan tree are displayed on the same hierarchical level.

Example: Subject Folders on Different Hierarchical levels
You can define a subject folder to be a subfolder of the preceding subject 
folder. To do this, use the Close Folder button to place the Close Folder mark 
for the parent folder after all its subfolders. 

For example, to define Subject_2 as a subfolder of Subject_1, and Subject_3 
and Subject_4 as subfolders of Subject_2, place the Close Folder mark for 
Subject_2 after the definitions of its subfolders. Place the Close Folder mark 
for Subject_1 at the very end.
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When the document contains paragraphs, place each Close Folder mark on 
its own line in the appropriate location. Note that the Close Folder marks 
for Subject_1 and Subject_2 are inserted after Subject_3 and Subject_4: 
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When the data is provided as a table, add a column to the end of the table 
and place each Close Folder mark in the appropriate location: 

After you export the test plan to Quality Center, Subject_2 is displayed as a 
subfolder of Subject_1, and Subject_3 and Subject_4 are displayed as 
subfolders of Subject_2.
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Deleting Formatting from the Document

To delete formatting from a document, you can use the undo buttons, or 
you can delete a mark manually.

Deleting Formatting Using the Undo Buttons
To delete the last mark you applied, or to delete all marks in the document, 
you can use the undo buttons to delete the bookmark and the icon for your 
most recent action or for all actions.

To delete formatting using the undo buttons:

 1 To delete you can:

➤ Click the Undo Last button on the Quality Center Common toolbar to 
delete the last bookmark and icon you applied.

➤ Click the Undo All button on the Quality Center Common toolbar to 
delete all bookmarks and icons in the document.

 2 A message box opens. Click Yes to delete the bookmark, icon, and text in 
the document. Click No to delete the bookmark and icon, and leave the text 
in the document.

Deleting Formatting Manually
You can delete any bookmark and icon manually. Note that deleting the 
icon or the text does not delete the bookmark. If your document contains 
extra bookmarks, an error occurs when you attempt to export to 
Quality Center.
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To delete formatting manually:

 1 Manually delete the icon.

 2 Choose Insert > Bookmark. The Bookmark dialog box opens.

Bookmark names contain the field name and an index number.

 3 Select the bookmark you want to delete and click Delete.
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3
Exporting Data to Quality Center

After formatting your requirement or test plan data, you export the data to 
Quality Center. 

When you export a new or existing requirement or test to Quality Center, it 
is created with the user name that you use to export it. For example, if you 
export a requirement to Quality Center with steve as the user name, the 
requirement’s history shows steve as the user that changed the requirement.

Note: You must have full create and modify permissions in Quality Center 
for requirements, the test plan tree, design steps, and subject folders.

This chapter includes:

 ➤  Version Control Considerations on page 37

 ➤  Exporting Data to Quality Center on page 38

Version Control Considerations

When you export data from Microsoft Word to a version control enabled 
project in Quality Center, consider the following:

➤ When you export a new requirement or test, it is created in Quality Center, 
with a checked in status. 
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➤ When you export an existing requirement or test that is checked in, it is 
automatically checked out during export. Quality Center adds a comment 
to the version history specifying that the requirement or test was updated by 
export from Word.

➤ When you export an existing requirement or test that is checked out by you, 
the data is exported. If the requirement or test is checked out by another 
user, the export fails and an error message is displayed. 

For more information on version control, refer to the HP Quality Center User 
Guide.

Exporting Data to Quality Center

You export data to Quality Center from your Microsoft Word document.

To export data to Quality Center:

 1 Define the requirements or test plans in your document. For more 
information, see “Formatting Requirement and Test Plan Data” on page 13.

 2 Make sure that the Quality Center Common toolbar is displayed. For more 
information on displaying the Quality Center Common toolbar, see “The 
Microsoft Word Add-in Toolbars” on page 14.

 3 To exclude marked data in your document from being exported, highlight 
the text area and click the Exclude Region button. A line is drawn through 
the selected text.
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 4 Click the Export to Quality Center button. The Quality Center Export 
Wizard - Step 1 of 5 dialog box opens.

Type your Quality Center URL:
http://<Quality Center server name>[:port]/qcbin.

 5 Click Next. The Quality Center Export Wizard - Step 2 of 5 dialog box opens.

Enter your Quality Center user name and password. 
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 6 Click Next. The Quality Center Export Wizard - Step 3 of 5 dialog box opens.

Select a Quality Center domain and project. 

 7 Click Export. The Quality Center Export Wizard - Step 4 of 5 dialog box 
opens.
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 8 If an error occurs while exporting the document, the Quality Center Export 
Wizard - Scan Error Report dialog box opens. 

Review the errors. To save the errors as a text file, click the Launch Notepad 
button. 

Click Close to exit the wizard. Correct the errors and start again at step 1 on 
page 38.

 9 If the data is exported successfully to Quality Center, the Quality Center 
Export Wizard - Step 5 of 5 dialog box opens. Click Finish.

 10 Refresh the view in Quality Center. Review the exported data and make the 
necessary additions and adjustments.
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